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What’s New in StorNext 4.7.0

Purpose of this Release StorNext 4.7.0 is an important release of StorNext that adds several features: 
StorNext 4.7.0 gives heavy users of StorNext Storage Manager better 
performance as their list of files to retrieves grows. Windows customers get 
better support for concurrent access control of files. Customers interested in 
connecting to Apple Xsan MDCs can take advantage of StorNext FX. Finally, 
customers with ACSLS libraries with multiple robots get support for more 
parallel tape operations.

StorNext 4.7.0 broadens the list of supported platforms.

StorNext 4.7.0 includes approximately 250 bug fixes and enhancements, more 
than 60 of which were directly requested by customers.

New Features and 
Enhancements in 
StorNext 4.7.0

Global Optimization of Pending File Retrieve Tape Mounts

StorNext 4.7.0 globally optimizes how tapes are mounted to satisfy pending file 
retrieve requests. When multiple files are requested from the same tape, 
StorNext will generally mount the tape just once to retrieve all of them, in tape-
position order, optimizing tape movement. In StorNext 4.7.0, this optimization 
happens across all requests. In prior releases, optimization only occurred within 
an individual request, for example, fsretrieve. Customers with large numbers 
of file retrieves that access the same tapes can expect to see performance 
improvement. For urgent jobs, customers can invoke the fsretrieve 
command with a new -p ("priority") flag to place the new job at the top of the 
list.

Better Support for Concurrent Access Control on Windows

StorNext now better supports Windows programs that limit concurrent access 
to files so that multiple users do not alter the same file at the same time. 
StorNext has long supported file locking, but Windows program like Office 
often rely on the Windows-specific Share Mode instead. In StorNext 4.7.0, 
Share Mode can be propagated to all Windows clients, blocking attempts to 
open an already-open file on a different machine. In earlier StorNext releases, 
Share Mode was only available on the local client. Because Share Mode can 
prevent concurrent file access that worked in earlier releases, Share Mode is 
disabled by default. See the snfs_config command in the MAN Pages 
Reference Guide for more details.

StorNext FX

As an outgrowth of this release, Quantum has revitalized StorNext FX, so that 
customers who need to access Apple Xsan file systems from current Windows 
and Linux operating systems can do so. StorNext FX now shares the same client 
architecture as the StorNext 4.7.0 client. Customers interested in StorNext FX 
should see the StorNext FX 4.7.0 Release Notes for details. StorNext FX is sold 
What’s New in StorNext 4.7.0 3
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separately, and licensed by client connected to an Apple Xsan Metadata 
Controller.

More Concurrency for ACSLS Libraries with Multiple Robots

StorNext 4.7.0 supports concurrent mount and dismount requests for Oracle 
ACSLS libraries with multiple robots.

New Operating System and Tape Drive Support

StorNext 4.7.0 adds the following new Operating Systems:

• Windows Server 2012

• Red Hat Enterprise Linux 6 Update 4

• Debian 6.0.5 and later 6.0.x as a StorNext Client

• Solaris 11 and 11.1 as a StorNext Client

• SUSE Enterprise Linux Server 11 SP 2 as a Metadata Controller, Distributed 
Data Mover, and Distributed LAN Client Gateway

Stornext 4.7.0 Adds Support for Oracle T10000D Tape Drives

StorNext 4.7.0 supports LTO WORM functionality where offered by the drive 
vendor, unlike earlier releases with more limited WORM support.

For full details of StorNext compatibility, see the StorNext and StorNext FX 
Compatibility Guide at http://www.quantum.com/sndocs.

Customer Reported 
Fixed Issues and 
Enhancements

The following table lists the customer reported fixed issues and enhancements 
for StorNext 4.7.0.

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description

All 1364964, 
1365444, 
1473898, 
896226

3546 Support Windows share modes cluster-wide

All 1217762 25007 Incorrect error reported by fspolicy -r when no relocation 
files detected.

All 1005184 27935 fs_fcopyman causes TSM startup to timeout

All 1128678, 
1569782

29187 Client holding file lock hangs on reconnect with global file 
locking enabled
4 What’s New in StorNext 4.7.0
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All 1293738, 
1291852, 
1345278, 
1391860, 
1514154, 
1318502

31456 NFS server panicked with: CVFS ASSERTION FAILED:  cvp-
>cv_magic == CV_MAGIC line 3132 file md_vnops.c 
module 0x34

All 1250142 33238 Missing .SHARED_FSNAME file error was not displayed by 
the GUI during HA system upgrade

All 1481860, 
1510404, 
1531872

34175 HAMgr connection failed: too many connections

All 1515122, 
1295102, 
1333452, 
1391508, 
1453638, 
1467954, 
1296558, 
1284070, 
1529652, 
1540070

34657 DiskInfo tac log mesages ”StripeGroup configuration 
contains 0 Disks” should tell us which file system it is 
reporting on.”

All 1387460, 
1340710, 
1401642

35218 Class limits not completely enforced.

All 1336560, 
1390454

35871 Multiple library robots are not used concurrently

All 1341370 36053 ArcDisp cores with signal 11 in HandleMoveEject

All 1350600 
1573190 
1574866

36127 When expanding the metadata stripe group, the allocation 
strategy needs modifying

All 1337734, 
1386160

36361 Activating fsm not responsive to voting clients

All 1360670, 
1361986, 
1373274, 
1449138, 
1548032

36412 Conversion of HA secondary fails with ”Error invoking 
action”

All 1394692, 
1449358

37366 Can’t delete excessive amount of Admin Alerts

All 1390454 37409 Extra ”emergency policy” log entries when running a 
normal class-based store policy

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description
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All 1387838, 
1404164, 
1465390, 
1494462, 
1533670

37430 Improve logging for revoke timeout

All 1392164, 
1406552

37621 fs_cpyresp performance is adversely affected by 
TRUNCATE IMMEDIATE operations

All 1403902 37756 GUI affinities page fails to load if affinity name is used > 1 
time

All 1464074 
1482682

38103 Metadata read error on wrong stripe group not detected 
and no core file

All 1429488, 
1528528, 
1537900

38512 fsm fails after upgrade from 4.2.1 with ASSERT failed (ip-
>i_idinode.idi_flags & InodeFlagPendFree) == 0

All 1434230 38701 cvfsck failure related to bad_name_list

All 1419636 38808 md_get_dirattrs() call does not display failing inode 
number in debug output

All 1438176 38948 Look at addressing the flood of not accessible and soft 
mount RAS from fsmcom.c

All 1438240 39036 Provide logging capability during sending metadata phase 
of replication

All 1554500 39510 fsretrieve of large number of files fails on retry when 
copy unavailable

All 1475478, 
1526280, 
1534060, 
1486380

39728 Misleading licensing error message generated by fsmpm 
when server components are installed but system is not a 
server

All 1479612, 
1511180

40033 GUI get Java heap space errors in the file recovery webpage

All 1477208 40303 Duplicate entries response is masked when inserting into 
MSM tables

All 1481180 40327 Error in MSM STK_DMOUNT_FAILED_LOG log message

All n/a 40370 fsstats to show counts for Policy Classes

All n/a 40393 Correct a confusing log entry

All n/a 40414 GUI Support handling multiple image files for M-series 
upgrades

All n/a 40421 Log in MSM appears to have incorrect information

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description
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All n/a 40432 Add crontab entries to snapshot to help with Debugging

All 1575178, 
1588104

40433 Same Request Ids being used for multiple commands

All n/a 40464 Forced Dismounts should be higher priority

All n/a 40480 Reallocation not working properly when using multiple 
drive pools.

All n/a 40483 Need to improve logs in TSM/MSM

All n/a 40484 Error in logs - cannot modify only mscnot field

All 1495072 40573 Bad xattrs not fixed by cvfsck

All 1441576 40638 TSM is incorrectly handling a WRITE dmapi event

All 1496086, 
1531520

40812 Install fails on mysql component if /adic has incorrect 
permissions

All 1496086 40813 Install continually fails on mysql component once a failure 
has occurred on this component

All 1510696 41108 When modifying policy class parameters, policy default 
copies is unexpectedly changed when File Age Before 
Truncation is modified

All 1503532 41376 snbackup takes too long to run because of database 
archive time

All 1504258 41383 fsmedscan does not handle consecutive tape marks

All 1522514 41394 GUI File and Directory Actions browsing fails on directory 
name containing single quote

All 1440472, 
1520800, 
1526530

41443 Running cvfsck on corrupt file system can result in 
thousands of messages.

All 1524676, 
1529000, 
1548710, 
1517124, 
1558576

41498 Library Capacity shown incorrectly in GUI home page (pie 
chart)

All 1530470, 
1550442, 
1545088, 
1556624, 
1568238

41721 Database crash during policy store

All 1537746 41866 GUI Tools > Storage Manager > LOI fails to process Audit 
Failure events

All 1543380 41956 A typo in .cfgx generates an ASSERT with no error logging

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description
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All 1359420, 
1514098,  
1537746,  
1349918, 
1497368, 
1556490

41995 consolelist database table not cleaned up

All 1543310, 
1571462

42079 GUI fails to display quota if the soft limit timer has expired

All 1480480, 
1349838, 
1354566

42146 Rename can update client size incorrectly from the fsm 
attributes

All n/a 42210 Typo in masarchive/config/mas_agent.ini.proto

All 1531542 42217 cvfsck randomly chooses inodes when double allocations, 
should clear both inodes

All 1552660 42323 Using wildcard with cvcp cause file overwrite.

All n/a 42398 MAS Agent can be disrupted by temporary absence of its 
config file

All n/a 42466 File names in fsmedinfo -l are pointing to .rep_private 
directory for deleted files

All 1547504, 
1470988

42527 Stripe Group Migration with GUI fails w/ Java out of 
memory

All 1526692 42530 Name space realization fails due to bad file descriptor 
errors in realize_namespace() on target side

All 1544884,
1558304, 
1560878, 
1554200, 
1567750

42532 When BindSame() recreate a ipv4 socket it assume TCP and 
does not set SO_REUSEADDR

All 1559338, 
1564374

42726 After cvfsck clobbered free list, many double allocations 
and took 67 hours to run.

All 1558610, 
1557572, 
1121384, 
1535590, 
1568914

42737 Backing up StorNext file system using EMC Networker 
produces errors getting extended attributes

All n/a 42784 StorageTek T10000D Tape Drive Support

All 1564670 42893 cvcp exit with status zero even on error. Cause script to 
assume copy succeeded.

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description
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All 1564496 42990 Pending free list problem can cause panic which we could 
fix without panic

All 1574832 43226 GUI RFE Add Policy Class filter to media report

All 1578258 43359 FSM OphangLimit Panic due to stuck journal pusher thread

All 1561322 43587 fs_store daemon uses select count(*)... query

All n/a 43947 GUI Lattus-M manual namespace mode not available with 
empty scan result set

Linux 1326764, 
1558768, 
1555748

36334 HA conversion of primary MDC fails because vsping 
executing when rpc service is stopped

Linux n/a 40535  nPulse, Custom Kernel Support

Linux n/a 40779 Add IBM TS1130 drive support for IBM TS3500 Library

Linux 1502162,
1487154,
1546212

40861 Race condition in M660 from udev causes Eth0 to 
disappear which results in license problems

Linux 1531432, 
1538246, 
1474334, 
1558768, 
1555748

41908 Check for portmap rpm depenedancy at install time 
required by MSM

Linux 1527928 41984 fsmedcopy heartbeat timer firing on long copies causing 
internal processing failure

Linux n/a 42011 Add licensing for MAS Agent

Linux 1540046 42216 DLC client filesystem hang when expanding with new 
unlabel drive.

Linux n/a 42267 Add licensing for MAS Agent

Linux 1564556 42889 High mysqld cpu utilization with large DLC configuration 
and gateway metrics enabled

Linux 1584402 43449 Creating a new mountpoint, The GUI limits the number of 
available characters in a filesystem mount name to 25.

Windows 1355798, 
1455446, 
1564876

36685 Windows Size on disk from explore properties is wrong

Windows 1463072 39379 Windows GUI adds an obsolete Stripe Group Type Regular 
parameter to the .cfg file

Windows 1468688 39981 cvgather -e does not work on 4.3.1 with data from 4.2.1

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description
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Visit www.quantum.com/ServiceandSupport for additional information and 
updates for StorNext.

StorNext Compatibility

For information on StorNext 4.7.0 compatibility with operating systems, kernel 
versions, hardware platforms, drives, libraries, StorNext Appliances, StorNext 
client interoperability, and other compatibility items, see the StorNext 
Compatibility Guide. SNAPI, Partial File Retrieval, and Apple Xsan compatibility 
information is provided in separate documents.

Quantum OS Upgrade 
Support Policy

StorNext supports any security or functional bug update that applies to the 
current StorNext-supported Red Hat update level or SuSE Linux Service Patch. 
StorNext does not support updating the update level or service patch beyond 
the currently supported levels shown in the StorNext Compatibility Guide 
available here:

http://www.quantum.com/sndocs

Supported StorNext Upgrade Paths

Sites running the following StorNext versions may upgrade directly to this 
release assuming the platform, service pack, architecture (32-bit or 64-bit), and 
StorNext component(s) are supported in this release:

• StorNext 4.3.2

• StorNext 4.3.3

• StorNext 4.6.0

• StorNext 4.6.1

All other versions of StorNext require additional steps to upgrade to this release.

Windows 1459308 40489 Windows: HA reset function may cause a BSOD

Windows 1466368 41151 Windows MDL leak causes memory usage to go up

Windows 1520442 41526 Windows active directory search can time out and lose 
synchronization with refresh credentials thread

Windows n/a 42756 SNFS 4.x not caching case insensitive file name matches in 
name cache

Operating 
System

Service 
Request 
Number

Change 
Request 
Number Description
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Note: Updates are intended to be done to all of the Lattus and metadata 
systems present in a given deployment (for example, if M662, A10, 
C10, S10 are present, they all must be updated, one appliance cannot 
be "left behind").

Distributed Data Mover 
(DDM) Guidelines

Distributed Data Movers (DDMs) must be upgraded to StorNext 4.7.0 when the 
Metadata Controller (MDC) is operating on StorNext 4.7.0. 

WARNING: Upgrades to StorNext 4.7.0 are intended to be completed to all of 
the Lattus Object Storage and Metadata appliances present in a 
given deployment. For example, if M662, A10, C10, S10 are 
present, they must ALL be updated; one appliance in a 
configuration cannot be “left behind”.

Compatibility Between StorNext and Other Products

This section describes various interactions between this release and StorNext 
components and features.

Lattus Refer to the Lattus Release Notes for information about compatibility between 
Lattus and StorNext 4.7.0.

Lattus Object Storage documentation is available here:

http://www.quantum.com/lattusdocs

Lattus A10 Refer to the Lattus A10 Release Notes for information about compatibility 
between Lattus A10 and StorNext 4.7.0.

Lattus Object Storage documentation is available here:

http://www.quantum.com/lattusdocs

Partial File Retrieval StorNext Partial File Retrieval (PFR) is a separately available product which 
enables you to quickly retrieve and utilize segments of large media files— rather 
than the entire file—based on timecode parameters.

Note: StorNext Partial File Retrieval (PFR) is not compatible with Lattus.

Refer to the StorNext Partial File Retrieval Compatibility Guide at this location for 
information about compatibility between PFR and StorNext 4.7.0:

http://www.quantum.com/sndocs
Compatibility Between StorNext and Other Products 11
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StorNext API (SNAPI) StorNext API (SNAPI) enables you to run third-party APIs with StorNext.

Refer to the SNAPI Compatibility Guide at this location for information about 
compatibility between SNAPI and StorNext 4.7.0:

http://www.quantum.com/sndocs

Apple Xsan Xsan is software that enables multiple Mac computers to concurrently access 
hundreds of TBs of content on Xserve RAID or Promise RAID storage over high-
speed Fibre Channel so creative artists can share data faster and consolidate 
projects. Quantum supplements this solution with StorNext data management 
software, enabling Apple Xsan customers to use applications running on 
Windows, Linux, and UNIX with their Xsan and share content across more 
systems.

Refer to the Xsan Compatibility Guide at this location for information about 
compatibility between Apple Xsan and StorNext 4.7.0:

http://www.quantum.com/sndocs

Supported System Components

Supported Browsers For information on browsers supported with the StorNext GUI for this release, 
refer to the StorNext Compatibility Guide available here:

http://www.quantum.com/sndocs

Known Issues

The following sections list known issues in this release of StorNext, as well as 
associated workarounds, where applicable:

• StorNext File System Known Issues on page 13

• StorNext Storage Manager Known Issues on page 15

• StorNext GUI Known Issues on page 17

• StorNext Installation, Replication, HA and Other Known Issues on page 18

Note: If you encounter one or more of the issues listed in this section, please 
contact Quantum Customer Support and report the issue(s) you 
encountered. Also inform the support representative whether you were 
able to successfully work around the issue(s) by using the provided 
workaround. Doing these things will help Quantum prioritize the order 
in which known issues are addressed in future StorNext releases.
12 Supported System Components
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StorNext File System 
Known Issues

Table 1 lists known issues specific to StorNext File System.

Note: Due to the formatting of the table, see Table 1 on page 14.
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Table 1  StorNext File System 
Known Issues

Operating 
System

Change 
Request 
Number

Service 
Request 
Number Description

Windows 41151 1466368 The StorNext Windows client may experience a memory leak under rare 
circumstances.
The memory leak occurs under the following conditions:
• A Windows SMB 1 client had mapped the StorNext file system.
• The SMB 1 client issues a server-side copy request.
• The Windows SMB server issues a "ChunkCopy" write request to the 

StorNext file system.
• The I/O is not eligible for Fast I/O processing.
In StorNext release 4.7.0, the code to prevent this leak is turned ON by 
default. If you are told by a Quantum representative this feature is 
causing a problem, you can turn OFF this code by changing a Windows 
registry setting.
To turn this code ON or OFF, follow the procedure in the Workaround 
below.

Workaround

To enable or disable this feature, add a new Windows Registry value 
under:

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\ADIC\CentraVision 
File System\1
Name: CvMdlFree
Type: DWORD
Value: 1 to enable, 0 to disable

Use the following detailed instructions to add the new value to the 
StorNext registry settings. StorNext must be installed before you can 
make this modification.

WARNING: Incorrectly modifying the system registry can cause 
serious problems with your operating system.

Note: Depending on the security on your system, you may need to 
have Administrator rights to change the registry.

Start Regedit:
1 Open the Run box with the keyboard combination Windows key + R.

2 In the Run line, enter regedit.

3 Click OK.
4 Click Yes to User Account Control if asked (Windows Vista/7/8).
5 Navigate to: 
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\ADIC\CentraVisio
n File System\1

(Continued on next row)
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StorNext Storage 
Manager Known Issues

Table 2 lists known issues specific to StorNext Storage Manager.

Note: Due to the formatting of the table, see Table 2 on page 16.

Note: Save the current values in the part of the registry you are 
changing. In the File tab, select Export and select a location to 
save the current values.

6 Add a new value named CvMdlFree with a DWORD value of 0.

a In a blank area of the right-hand panel, right-click and select 
New > DWORD(32-bit) value.

b New Value #1 appears, and will be highlighted. Click this 
name, change the name to CvMdlFree, and then press Enter. 
The value will default to 0 (feature disabled.)

c To enable this feature, right-click on the name CvMdlFree and 
select Modify....

d In the pop-up labeled Edit DWORD (32-bit) value, enter the 
value 1 to enable the feature.

e Click OK.
7 Restart StorNext by:

a Rebooting your system, or
Note: Click Start > StorNext File System > Service Stop, then > 

Service Start.

Operating 
System

Change 
Request 
Number

Service 
Request 
Number Description
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Table 2  StorNext Storage 
Manager Known Issues

Operating 
System

Change 
Request 
Number

Service 
Request 
Number Description

Linux 43246 1568166 If connectivity faults occur when transferring data from StorNext 
Storage Manager to and from Lattus, consider using less sensitive 
offline of iopaths and media.

Workaround

The workaround for this issue is to add the following lines to /usr/
adic/TSM/config/fs_sysparm_override and then restart StorNext 
Storage Manager:

FS_THRESHOLD_INC_NUM=0;
MEDIA_SUSPECT_THRESHOLD=32767;
Note: If you store data to tape, changing these settings will affect the 

normal behavior for dealing with unreliable media and tape 
drives.

Linux 43156 n/a Description

SUSE Linux 11.1 can suffer excess CPU overhead for some data patterns 
because it uses compression during https transfers to Lattus.
Note: This only applies to SUSE Linux 11.1. The issue is fixed in SUSE 

Linux 11.2. SUSE Linux 11.0 is only supported on a client for 
StorNext and the issue does not occur. SUSE Linux 10, Red Hat 
Enterprise Linux 5, and Red Hat Enterprise Linux 6 avoid 
compression.

Workaround

To turn the compression Off, apply the Operating System patch 
described on the following Web page:
https://www.suse.com/support/update/announcement/2013/suse-su-
20130549-3.html

Linux 44144 n/a Description

Wide Area Storage I/O path is taken Offline due to exceeding its failure 
threshold.

Workaround

If the WAS configuration is changed for DDM clients or access protocol, 
then Storage Manager needs to be stopped and restarted to avoid this 
failure condition.
16 Known Issues
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StorNext GUI Known 
Issues

Table 3 lists known issues specific to the StorNext GUI process.

Table 3  StorNext GUI Known 
Issues

Operating 
System

Change 
Request 
Number

Service 
Request 
Number Description

All 44249 n/a On the StorNext GUI, clicking the context-sensitive help icon on the 
Tools > User Accounts Web page displays content of an older and 
obsolete User Access help page.

Workaround

To display the User Accounts help page, perform the following steps 
on the StorNext GUI:
1 Click the non-context-sensitive help icon in the upper-right corner, 

located to the left of Log Off. The StorNext Online Help appears 
and the List of Topics help page is displayed.

2 On the List of Topics help page, scroll down to the Tools Menu 
Options section, and then click the User Accounts hyperlink.

All 44454 n/a Description

The StorNext Man Pages Reference Guide, first introduced in StorNext 
4.3.0, has replaced the obsolete StorNext CLI Reference Guide. A dead 
link to the StorNext CLI Reference Guide incorrectly remains accessible 
from the StorNext GUI, when you click Documentation on the Help 
menu.

Workaround

The StorNext Man Pages Reference Guide is also available at 
 http://www.quantum.com/sndocs.
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StorNext Installation, 
Replication, HA and 
Other Known Issues

Table 4 lists known issues specific to StorNext installations, data replication, HA 
systems and other areas.

Table 4  StorNext Installation, 
Replication, HA and Other 
Known Issues

Operating 
System

Change 
Request 
Number

Service 
Request 
Number Description

All 44076 n/a Cache Clustering is not supported in the Lattus 3.1.4 release.

Workaround

Support for this feature will be enabled in a future Lattus release.

Linux 38197 n/a Quantum has updated the priority Queuing in StorNext 4.7.0. If you 
changed StorNext Storage Manager priority Queuing by modifying the 
/usr/adic/TSM/config/pri.config configuration file, your 
changes ARE NOT overwritten. Quantum recommends you look at the 
new queuing priority below and take this into consideration of your 
file. The changes below increase the default reprioritization age times 
for both retrieves and stores so that requests stay in their current 
priority longer, in order to take advantage of internal changes made to 
the request queue management, in an effort to minimize tape mounts 
and tape positioning.

Workaround

Quantum recommends that you incorporate the changes under the 
NEW values heading below, if necessary. The default age time has been 
increased for priorities 4 through 7 as follows:

OLD values
4 :  6 :  4 : 5
5 :  8 :  6 : 10
6 : 10 :  6 : 20
7 : 12 :  6 : 20
NEW values
4 :  6 :  4 : 20
5 :  8 :  6 : 20
6 : 10 :  6 : 25
7 : 12 :  6 : 25
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Contacting Quantum

More information about this product is available on the Quantum Service and 
Support website at www.quantum.com/ServiceandSupport. The Quantum 
Service and Support website contains a collection of information, including 
answers to frequently asked questions (FAQs). You can also access software, 
firmware, and drivers through this site.

Operating 
System

Change 
Request 
Number

Service 
Request 
Number Description

Linux 41548 n/a Due to the way the binary logging is configured, warnings in the 
mysqld.log appear when mas_agent is running.

Workaround

When running the StorNext MAS Agent for Harmonic component, 
Quantum recommends that you ignore warning messages of the 
following form seen in the /usr/adic/mysql/logs/mysqld.log file:

130220 16:27:54 [Warning] Unsafe statement written to 
the binary log using statement format since 
BINLOG_FORMAT = STATEMENT. Statements writing to a table 
with an auto-increment column after selecting from 
another table are unsafe because the order in which rows 
are retrieved determines what (if any) rows will be 
written. This order cannot be predicted and may differ 
on master and the slave....

Linux 44208 1597918 Description

An appliance upgrade does not enable multipathd if a custom 
multipath.conf file exists in the /etc/ directory. 

If you upgrade to StorNext 4.3.2 or StorNext 4.3.3 and the system is 
not already running multi-path, do not place a custom 
multipath.conf file in /etc/ until after the upgrade is completed. 
The upgrade for 4.3.2 and 4.3.3 does a conversion from RDAC to DM-
MP but this conversion will not take place if a /etc/multipath.conf 
file already exists on the system.

Workaround

If you require a custom multipath.conf file:

1 Perform the upgrade to StorNext 4.3.2 or StorNext 4.3.3.
2 Allow the upgrade scripts to perform the full conversion and 

enabling of multipathd.

3 Upload the custom multipath.conf file on the system.

4 Restart the system.
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To request a software upgrade, visit www.quantum.com/ServiceandSupport/
Upgrade/Index.aspx. 

For further assistance, or if training is desired, contact the Quantum Technical 
Assistance Center: 

(Local numbers for specific countries are listed on the Quantum Service and 
Support Website.)

North America +1-800-284-5101 (toll free)
+1-720-249-5700

EMEA +00-800-7826-8888 (toll free)
+49-6131-3241-1164

APAC +1-800-7826-8887 (toll free)
+603-7953-3010

Online Service and 
Support

www.quantum.com/OSR

Worldwide Web www.quantum.com/ServiceandSupport
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